Mac OS Essentials a la Steve Leary
Part 1, Saving Files As a PDF
Part 2, The Pages App
Session 4, July 10, 2025

There are several ways to save files as a pdf...

1. There are several apps that will export your file as a pdf.

a. Pages
b. Numbers
c. Keynote

2. Some files can be downloaded from Safari as a pdf file.

3. Through the Print dialog box.

Printer = HP OfficeJet Pro 9010 series ¢

Presets Default Settings ¢

Copies 1| £

Pages
© All 5 Pages
Range from 1 to 1

Selection
Select pages from the sidebar

Print in Color «©

Double-sided off ¢

Pages

Print commen ts
Print smart annotations
@ Print page backgrounds

cancel (TR

4. Choosing “PDF” gives you several options, among which are...

a. Opening the file in Preview allowing you to see how the printed file will look

paper.
b. Saving the file as a pdf.
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Converting files to pdf format

Printer

Presets

Copies

Pages

O All 31 Pages
Range from
Selection

T= HP OfficeJet Pro 9010 series

1 to 1

Select pages from the sidebar

Print in Color

Double-sided

Pages

Madia & Nnalitv

=)
j

Click here to open
this dialogue box.

Print comments
Print smart annotations

Print page backgrounds

Save as PDF...
Save as Postscript...

Save to iCloud Drive
Save to Web Receipts
Send in Mail

Add Document to Neat
Add Contact to Neat
Add Receipt to Neat

Edit Menu...

<>

Default Settings ¢
1€
«©
off ¢
e
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This is the name assigned to the file\

Gave As: | 3.1 Mac Essentials, Rev.3.pages.pdf )
Spending Receipts Tags:

Websites -
: 2 (: Rev. 3, 2025.06.26 Prese.) ~ Q
NCBG Botanical lllistrat...

=
[y

«Q
7}

ii
<
|

Tax Year 2025 Name Size Kind Date Added

NCBG Botanical lllistrat...

Sony Cameras 2
Tax Year 2024

Apple Academy

Apple Academy Presen...

Apple Maps Guide

Title: 3.1 Mgc Essentials, Rev.3.pages

Bird Photos & Videos
Author: Car

Stuff Locator .
Subject:

Eclectic ltems Keywords:

00 Page Templates
Security Options...

Special Characters for...

B1 Banking & Securitie...

New Jolder Cancel

® ¢ O € O O O O O O O O @@ O o o

B2 Brokerage Accounts

This is the folder where the file will be placed

You can drag the folder name and release it anywhere on this window.
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Open in Preview
Converting files to pdfs and opening in Preview ;—m—:ave s POF..

Save as Postscript...

- N
®o £ ~ )untitied 2@ O ® 2 - & G Save to iCloud Drive
Click here... ' Save to Web Receipts
St Send in Mail

Then click on “Thumbnails” to open

. Add Document to Neat
Mac Essentials a la Steve Leary

Add Contact to Neat
Add Receipt to Neat

ite a few Apple Academy meetings and I've always thought the Academy
presentations wer&Ngcking in one area; i.e.,understanding the Mac Operating system and

how it enables you to effegtively use a real, live Apple Compiiter Edit Menu...

To rectify this deficiency, | will, Stqrting with the Apple Acad \/ H ide Sidebar

presentations on MacOS and the appg have found to be mi

presentations will follow a short break a ur normal iPhor .

swim in the Microsoft PC pond a chance to le2wg the meetir Thu mbnal IS

allotted room time. C t t
ontents

...to open this
hts and Notes

marks

Contact Sheet

thumbnails of the document’s pages
in the sidebar. Continuous Scroll

®

Single Page

Two Pages

Choose sidebar display . <
Mac Essentials a la Steve Leary

I've attended quite a few Apple Academy meetings and I’ve always thought the Academy
presentations were lacking in one area; i.e.,understanding the Mac Operating system and
how it enables you to effectively use a real, live Apple Computer.

To rectify this deficiency, | will, starting with the Apple Academy in May, give a series of
presentations on MacOS and the apps | have found to be most useful to me. My
presentations will follow a short break after our normal iPhone/iOS subject giving those who
swim in the Microsoft PC pond a chance to leave the meeting, and last until the end of our
allotted room time.

Drag the thumbnails into the folder where you wish to store the file.

NOTE: Links in the original document are preserved when the jpg file is created. The
links are also preserved in the thumbnails.
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l. Working with files in Preview

A. Filesin Preview can be saved using the “Save” or “Save as” options

1.

Using the “Save” option. Be careful using this option ... you may not know where
folder your file has been saved

Using the “Save as” option opens the save dialog box allowing you to specify
where the fill will be saved.

B. Only thumbnails can be dragged to a folder.

1.

One, several, or all thumbnails can be dragged to a folder.

C. Working with thumbnails

1.

2.

Thumbnails are shown in the left sidebar.

Individual thumbnails can be deleted by clicking on them and pressing the delete
key.

Pages can be rearranged by dragging their thumbnail to a different location.

Thumbnails from a different document can be added together by dragging
between files.
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. Page documents can be either a Word Ll Lol o S e S s

Processing document of a Page P00 New...
Layout document. 0 1268 Open::
; Open Recent >
A. In Word Processing documents, text View 2o
flows from one page to the next. Text Close
flows around any imbedded images Save
Save As...
B. In Page Layout documents, text flows )
Duplicate
from one text block to the next...you e
control this. You must shape text
. . Move To...
blocks around imbedded images.
Revert To >
C. You can convert from one to the other;
; Share...
however, if you convert from Word
Processing to Page Layout you will
loose any text not in a text block. Export To >

Publish to Apple Books
Il. Initiate a Page document

A. Choose the Page app from your Dock
or Application Folder Convert to Page Layout

Reduce File Size...
Advanced >

1. Click on the File menu, then...

a) New to bring up the Template

Chooser Set Password...

b) Open to open an existing Pages ZENE 8 I,

document. Page Setup...

c) Open Recent to choose from a Print...

list of the last ~50 Page files
you have opened.

B. If you select “New,” the Template
Chooser appears.
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Choose your template (in this case, the Word Processing option) and click

“Create”

1.
C. Setting up your document.
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[ ] @ 4 Session 4, Section 1 Word Processing for Examples.pages
O 125%v B Q o= = © 8= B
View Zoom Print  Add Page Find Insert Text Shape Track Changes Table Media

Session 4, Section 1 Word Processing for Examples.pages

1. The “Format” and “Document” icons in the upper
right window corner are toggles that control the
right side bar.

A B

Format Document

When the “Format” icon is active, you can specify
how the text appears in your document.

When the “Document” icon is active, you can
specify the paper size as well as the border,

header and footer distances from the paper’s
edge. Other layout options are also available.

2. Clicking on the active icon toggles the right
sidebar between “displayed” and “hidden.”

Mac Essentials, Session 4, Pages Page 3 of 19

® 0 & B

Chart Share Format  Document

Text

Heading

Style Layout

Font

Bangla Sangam MN
Bold )
oo

Character Styles  None

Text Color &

v
il
11
-

Spacing
Lines &
Before Paragraph

After Paragraph

Bullets & Lists  None

No Bullets
Indent: 0in C
Bullet
Drop Cap

More

»

15pt o

$iv

v

0 pt C

0 pt C

A
v

. ~
0in o

Text
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D. The “Document” option consists of three sections:

m Section Bookmarks
Printer & Paper Size
Any Printer ¢
US Letter £+
Page Orientation
v
8.50 x 11.00 inches
v Header v Footer
0.75in 05in
Top Bottom
v Document Body
Document Margins
1.25in < 0.75in T
Top Bottom
1in C 1in C
Left Right

Facing Pages

Hyphenation

Vv Ligatures

Mail Merge

Mac Essentials, Session 4, Pages

Document m Bookmarks

Document Section

Background

Headers & Footers
Hide on first page of section

Match previous section

Page Numbering

Format

Numbering

Create a new section (]

Sections allow you to start a new header
and footer, page numbering, or page
background.

Add bookmarks, then link to them from other
places in your document.

Add Bookmark

Use the “Document” section for paper size, orientation,

and margins.

Use the “Section” section to hide headers and footers
on the first page of a section, page numbering format

and creating a new section.

Use the “Bookmarks” section to add internal links

within your document.

Page 4 of 19
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E. Formatting Text - The Style Section

1. The Style name or designation. This is the
name under which all the specs governing
text appearance are stored; i.e., everything
in the “Style” “Layout” and “More”
subsections. (These are called “Paragraph
Styles.”)

2. Bullets & Lists are treated as special
formatting added to the text formats
described in 1 above. (These are called
“List Styles.”
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Heading

Style

Font

Text

Layout

Bangla Sangam MN

Bold

i

U S

Character Styles  None

Text Color £

Spacing

Lines <

Before Paragraph

After Paragraph

Bullets & Lists None

No Bullets

Indent:

Drop Cap

0in C
Bullet

More

<>

0 pt

<>

0 pt

D<)

Oin
Text
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F. The Layout Section Text

1. Inthis section, you specify the number
of columns in your document, Section Header v
paragraph indents, tab spacing,
whether you wish to have borders

around your paragraphs and their Style Layout IO
styles as well as any paragraph
backgrounds Columns 12
Indents
G. The More Section 0in 2 Oin 2 Oin 2
First Left Right
Text
Tabs
Section Header v Decimal Character
Default Spacing 0.5in C
Style Layout More Stops Alignment Leader
Pagination & Breaks
Keep lines on same page
Keep with next paragraph +
Start paragraph on a new page
Prevent widow & orphan lines Paragraph Borders
None < 0 pt
Hyphenation & Ligatures
Remove paragraph hyphenation
Remove ligatures Border Offset 6 pt
Following Paragraph Style
Body with %" Left Indent < Paragraph Background P o

Mac Essentials, Session 4, Pages Page 6 of 19
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H. Page Settings

For New Documents:

Default Zoom:

Default Font:

Editing:

Invisibles:

Adding Media:

Touch ID:

Author:

Text Size:

Session 4 — Pages

General

o3 [0 Abc

General Rulers  Auto-Correction

O Show Template Chooser
Use template:

Use My Card from Contacts to populate sender information

125% a
Set font and size for new Basic documents

Bangla Sangam MN 12 pt Change...

Curves default to Bézier
Show suggestions when editing table cells

Paste YouTube and Vimeo links as web videos
Optimize media for iPhone and iPad
Optimize media for older devices

Movies and images will keep their original formats, but they may not
display on all devices, or in all versions of macQOS, iOS, and iPadOS.

Use Touch ID

Use your fingerprint to open password-protected documents.

Steve Leary

Name used for comments and tracked changes when you're not
collaborating.

12pt @

Default text size for comments.

Mac Essentials, Session 4, Pages
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() Rulers

& E° A

General Rulers  Auto-Correction

Ruler Units: Inches )

Show size and position when moving objects
Place origin at center of ruler
Display ruler units as percentage

Show vertical ruler whenever rulers are shown

Alignment Guides: | |

Show guides at object center
Show guides at object edges
Use haptic feedback when snapping to guides

Page Template Guides: [

O Auto-Correction

& B Abc

General Rulers  Auto-Correction

Spelling: Correct spelling automatically Ignored Words...
Capitalize words automatically

Formatting: Automatically detect lists

Automatically add links to webpages and emails

Automatically add links to phone numbers
Automatically apply link style

Superscript numerical suffixes

Automatically format fractions

Use smart quotes and dashes
Double quotes  “abc”

Single quotes  ‘abc’

Replacement: Symbol and text substitution

Replace ~ With
(c) ©
(®) ®
(r) ®
clo Y%
TM ™

+ -

Mac Essentials, Session 4, Pages Page 8 of 19
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|.  Exporting Pages document to Word.

File Edit Insert Format Arrange View Window

AN

Export To

Mac Essentials, Session 4, Pages Page 9 of 19
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J. RevertTo

ON
0 12
View Z
== T 7\|\|mm|\

5 . | |

——— 17
0 E L

s == M

Revert To Last Saved — Today, 2:17PM

Last Opened — Today, 3:22PM
Browse All Versions...

Click on “Browse All Versions...” to bring up
screen shown on next page.

Mac Essentials, Session 4, Pages Page 10 of 19
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K. Text Blocks LA
Text

Drag the nodes to resize the text block:

o O o
Type to enter text

(] [m]

[m] O O

While hovering over a node, if you hold down
the “command” key the pointer changes from a
straight line with arrow points on each end to a
curved line with arrow points on each end. Click
and drag to rotate the text block. Holding down
the shift key while rotating the block will snap
the rotation to 45° increments.

Text properties within the text block are based on the paragraph style selected when
entering text into the text block.

Mac Essentials, Session 4, Pages Page 12 of 19
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L. Managing Paragraph Styles Text

1. Click on the white area to bring up
this menu. Section Header

2. From here you can select a different
style for your paragraph or you can

click on the “+” sign in the upper Document Header
right corner to create a new style.

Paragraph Styles

v Section Header
3. Hover over one of the styles brings Body

up a “>”icon to the right side of the

Body with 4" Left Indent
menu.

Body with 2" Left Indent

File Link Format

Footnote

Body with...ceeding Line

4. Click on the icon to bring up this sub
menu.

5. Here you can Rename the Style,
Delete the Style, and assign a ‘ Rename Style
Function Key as a shortcut for Delete Style...
selecting the style. i

Shortcut
[

Mac Essentials, Session 4, Pages Page 13 of 19
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M. Managing List Styles
Bullets & Lists None @
1. Clicking on the down caret to
brings up the List Styles dialog No Bullets ¢
rmenu: Indent: 0in C Oin C
Bullet Text
List Styles
2. Choose your type of List Style y v
None
3. Click on the “+” sign in upper 7
right corner to add a new List - Bullet
Style based on the List Style - Bullet Big
selected.
O Image
4. For List Styles to work properly, A. Lettered

the “Following Paragraph Style”
in the “More Section” above
must be set to “Same.” |. Harvard

- Dash

1. Numbered

- Note Taking

Mac Essentials, Session 4, Pages Page 14 of 19
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G ® ) L B >
N. |nserting imagesinto your Chart  Share Format Document

document. Media +

Object Placement

1. Click on the Media Icon or drag an
image file onto the text.

Stay on Page Move with Text
2. With the image file selected, click on Text Wrap
“Arrange” in the upper right corner of Z= Around
the right sidebar. = = 12pt 2 50% o
Text Fit Spacing Alpha
3. Choose the method to flow the text
around the image. .
v = Around
& Above and Below

D

-8. Inline with Text

I 1
7=
o
3

Lorum.lpsum.(20.Paragraphs)

§[1:.Lorem.ipsum.odor.amet,.consectetuer.adipiscing-elit..Urna.volutpat.aenean.tincidunt.
efficitur.purus.et..Donec.praesent.dui.tempus.sagittis.est.habitant.consectetur.ullamcorper.
neque..Pretium.senectus.primis.fringilla.tellus.commodo.dis.penatibus.laoreet..Tempor.
venenatis.vehicula.cubilia.placerat,.volutpat.taciti.porta.ultricies..Mus.eleifend.fringilla.erat.
fermentum.turpis.fusce.aliquet..In.id.per.blandit,.ad.est.sodales.est..Faucibus.nam.suscipit.
eros.eros.porta.in.dolor..Viverra.consequat.massa;ultricies.ullamcorper.ultrices.faucibus.q|

§]2..Interdum.id.sem.pellentesque.habitant.finibus..Vel.scelerisque.cubilia.nisl;.enim.varius.

libero.dis.. 5 O , Finibus.suspendisse.
est.ultricies. magna.montes.
rutrum.eu. suscipit..Conubia.
quisque. tempus.bibendum.

bibendum.habitant.
Sodales.felis.congue.
nostra.condimentum.

aliquet.urna.
mollis.dictum.
taciti.aliquet.

dapibus. senectus..Molestie.
facilisis. aliquet.nisl.
maecenas. quam.tempus.
sollicitudin. class.dolor..Aptent.
facilisis.velit. o O o vulputate.phasellus.
donec..Mauris. phasellus.lobortis.
morbi.blandit.aenean.malesuada.per.vehicula.fringilla..Cubilia.nullam.lacinia.lacus.urna.donec
dui.g
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0. Show/Hide Invisibles

Hide Tab Bar
1. A toggle found in the View menu Show All Tabs
2. Invisibles are the blue dots denoting spaces SRS >
between words, pilcrows ({]) denoting a v Page Thumbnails
carriage return—line feed between Table of Contents
paragraphs and other hidden formatting Document Only
symbols. Show Word Count
Hide Rulers
Guides >
Go To >

P. Menlo — A special font you might want
to consider using for displaying

Edit Page Templates

Show Layout

passwords. ( Hide Invisibles )
Helvetica Menlo
a b c d a b C d
= f g h e f g h
OO « O OO « O
m n 0 p m n 0 p
q r S t q r S t
u v w u V w X
y 'z A B y 'z A B
C D E E C D E F
G H @ @ G H @ @
K L M N K L M N
O P Q R o P Q R
S T u Vv S T b v
W X Y y4 X Y Z
@ 1 2 3 1 2 3
4 5 6 7 4 5 6 7
8 9 8 9
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Q. Grouping, Ungrouping and moving Objects,

Grouped Ungrouped
a b c d a b C d
e f g h e f g h
OIONNOINOIONNO,

S
(@)
©
)
(@)
©

<
<

m > =
w
m >» =
w

OO

X <4 UV r I U N
X 4 W r I U N

o N < C O Z
N WO N < T Z
o N < C O Z
N o N < T Z

(63
(63

mp@ém0x90~<cgg
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File Edit Insert Format Arrang

R. Saving a personal template to the Template Nev

Chooser Open...

1. Once you have a created a document Open Recent >
you are happy with...all the styles are
what you want, all margins, headers and

Close Window

. Save
footers are correct, paper size, etc.; Save As..
create a copy. Dl
2. Working with the copy, delete all the Rename...
texts and included objects from the Move To...
copy you do not wish to appear in the Revert To >
template.
Share...
3. Select the style you want to use when
you will start the new document.
Export To >

4. Then, under the File menu, select “Save Publish to Apple Books
as Template... and follow the
instructions for creating a personal
template in the Template Chooser. Convert to Word Processing

Reduce File Size...
Advanced >

Set Password...

CSave as Template..)

Page Setup...
Print...
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References...
A. MacMost.com

1) Learn How to Use Mac Pages in 5 Minutes

2) 10 Mac Pages Tips

3) Moving Pages or Text Around in Mac Pages

4) 31 Mission Control Tips
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http://MacMost.com
https://youtu.be/HZnrtWIAr_Y
https://youtu.be/xrtHiwBh0rM
https://youtu.be/iO-PlAadJrM
https://youtu.be/vj4tYfGnezg

